
 Introduction
Congratulations on obtaining ACDSee 32, the fastest and easiest-to-use image viewer available for 
Windows 95 and Windows NT!      ACDSee is two tools in one.    A full-featured image viewer quickly 
displays your images in high quality.    The image browser lets you efficiently find and organize your 
images.

Image Viewing As an image viewer, ACDSee stands 
unsurpassed in its ability to quickly decode and 
display images.

· Speed - Using its efficient decoder with incremental display, ACDSee displays images faster 
than any other image viewer.

· No waiting -    multithreaded design means you can use other functions while ACDSee is 
processing -- you’ll spend less time waiting and more time doing.    

· Less memory is required to view images than with full-fledged image editing applications.
· High quality output - ACDSee gives you single and two-pass dithering algorithms that make 

optimal use of your display’s capabilities.    
· Support for most popular image formats - BMP, DCX, GIF (including animation), IFF, JPEG, 

PCD, PCX, PIC, PNG, PSD, TGA, TIFF (including multi-page) and WMF
· Scroll, manual and auto zoom, auto-window size and full-screen mode features allow you to 

view your images the way you want.
· Slide show gives you the ability to view a sequence of images automatically.    ACDSee provides 

read-ahead decoding, subfolder searching, forward/reverse/random and single/loop sequencing 
features.

· Print your images along with names and descriptions.    Several images can be printed at once as a
batch.

Image Browsing ACDSee is the best choice for browsing images 
in your file system.

· High-speed preview lets you quickly and easily take a peek at images without interrupting or 
slowing down your exploration.

· Thumbnail mode shows a thumbnail of each image instead of the normal file icons, allowing you to
visually browse more quickly through many images.    

· Rapid File management utilities including drag-and-drop and cut-and-paste allow you to quickly 
organize your images and other files into folders.    

· Visual overwrite confirmation shows you source and destination images side by side before 
overwriting images when copying or moving.

· Auto-skip can automatically skip copying or moving files if they already exist in the destination 
folder.

· The shortcuts pane, a feature unique to ACDSee, allows you to quickly move and copy files to a 
user-configured list of frequently used folders.    Or, you can also use the list to browse frequently 
used folders.

· File descriptions allow you to annotate any file with a descriptive phrase without altering the name 
or contents of the file.

· Customized file details allows you to configure how and what information about your files is 
displayed. 

· Desktop wallpaper commands allow you to quickly change your desktop background to any 
image, centered or tiled.

· File conversion also allows images to be quickly and conveniently converted to JPEG or BMP 
format.    A batch of files can be converted all at once.

· Copy to clipboard allows you to copy images from ACDSee into other applications.    
· Shell edit commands allow you to quickly open your images in your favorite image editor 

applications.



· A File list generator gives you a text listing of the files in a directory, including descriptions, file 
type, size, image dimensions and date.

· Shortcuts to images (.LNK files) are handled transparently, allowing you additional flexibility in 
organizing your images.

User Interface As a whole, ACDSee provides an efficient 
interface which has been highly optimized to 
minimize the amount of key punching and 
mouse pushing you need to do to get things 
done.    

· ACDSee completely avoids the bulky, slow interfaces that plague most Windows software products 
in favor of streamlined operations.    

· Whether you like to use the mouse or do it all from the keyboard, ACDSee provides you with the 
short cuts you need to do it quickly.    

· To get you up and running quickly, ACDSee incorporates full on-line help with tool tips and 
context-sensitive pop-up help.

· Extensive customization options allow you to configure ACDSee to work the way you want it.



Image Formats Supported
BMP Windows Bitmap Windows and OS/2.    2/8/16/24/32 bpp.    RLE and 

uncompressed.    BI_BITFIELDS encoded not supported.
DCX Multiple-page PCX All sub-types and multiple pages supported.
GIF Graphics Interchange 

Format
Single page and animated.

IFF EA Interchange File Format 1-24 bpp, including HAM and HAM8. Multiple pages and 
animations not supported.

JPEG JPEG JFIF JFIF and Adobe CMYK.
PCD Kodak PhotoCD 512x768 and 768x512 resolutions.
PCX ZSoft Publisher’s Paintbrush All sub-types supported.
PIC SoftImage PIC All sub-types supported.
PNG Portable Network Graphics All sub-types supported.
PSD Adobe PhotoShop 

Document
RGB, grayscale, duotone, paletted and bi-level. Lab colour and 
16 bpc not supported.

TGA Targa TGA All sub-types supported.
TIFF Tag Image File Format 1,8,24,32 bpp.    Uncompressed, PackBits, LZW, CCITT 

Group 3 & 4, ZIP, NEXT, new JPEG.    
Support for multi-page documents.

WMF Windows Metafile Format Win 3.x embedded metafiles.    (Enhanced metafiles not 
supported)



What’s new in ACDSee 32 version 2.21?
Legend

+ New feature
o Minor change
!! Bug fix

Changes since version 2.2
+ added support for DCX format (multi-page PCX FAX)
o reduced memory overhead for loading GIF images
o the file list is automatically updated when files are dropped into it, even if the "auto-refresh" option is 

turned off
!! file list would sometimes auto-refresh continuously when running on Windows 95 and "Cache in 

descript.ion" and "Reading image information" and "Auto-refresh" options were turned on
!! some interlaced animated GIF images were not decoded properly
!! problem handling animated GIF images with missing GCE's
!! round-off error could cause horiztonal lines to appear when decoding interlaced images at a high 

zoom level
!! fixed problem with "View all images in folder" not working when ACDSee was started on the 

command line

Changes since version 2.1
+ Added support for SoftImage PIC format
+ Shortcuts to images are now handled transparently
+ Added Cut, Copy and Paste commands to Browser for file management
+ Added Copy Image commands to allow images to be copied to the clipboard
+ Added Paste command to Viewer to allow files copied from Explorer to be pasted into the image list
+ Revised Move/Copy Overwrite options, adding auto-rename
+ Added “Slideshow” and “Slideshow Recursive” commands to Viewer
+ Added "Save defaults" button to Options dialog – options are no longer permanently saved when OK 

is pressed
+ Added shell open/edit commands to Viewer
+ Added option to hide Browser path box (“View > Controls > Path box”)
+ Added Remove All command to Move/Copy Files dialog box
+ Added “Tools > Generate File List” command
+ Added “Image List > Highlight Image Files” option
+ Added “/p” command line option for printing images
+ Added FileName edit box to Move/Copy Files Dialog box when a single file is being moved to allow it 

to be renamed
+ Added “Apply to all” checkbox to Edit File Description dialog to allow a single description to be applied

to several files at once
+ In full screen mode, you can press and hold down the b, t and m keys to temporarily show the status 

bar, the tool bar and the menu, respectively.
+ "Oem convert" option for file descriptions
+ Option to show full image file path in Viewer
+ “Show hidden files” option is now available directly from the Browser window (View menu or Ctrl+H)
o Added selected file name to status bar of Browser
o Changed default renamed file in Move/Copy to use a unique postfix number instead of “Copy of…”
o Added option to disable open/remove commands
o "Exit after delete/move" now causes the Viewer to exit to the Browser when the last image in the 

image list is deleted or moved (only if ACDSee was started in Browser mode)
o Internal move/copy is used for drag and drop file operations now (except folders)
o Added new Read Image Headers option : "Only on non-floppy and non-CDROM disks"
o Numeric keypad +/- now expand/collapse items in folder tree
o The current parent folder name is shown in the title bar of the Browser



o Added keyboard shortcuts to help menu
o Rearranged Browser File List context menu
o Reversed the meaning of Ctrl and Shift when applied to Delete command to better
o Limited WMF bitmap size to prevent use of too much memory when displaying WMF files of large 

dimensions
o Added support for IFF-HAM, IFF-HAM8 and IFF-EHB
o Added support for TIFF-CMYK, PSD-CMYK and JPEG Adobe CMYK
o Prevented selection of next item in list if a multiple move operation was just completed and all files 

were successfully moved.    Instead, the next item just receives the focus.
o The setting of    the “Hide non-image files” option is no longer automatically saved on exit
o Preview/Next Page commands added to Viewer toolbar when a multi-page image is viewed
!! several problems displaying animated GIF images
!! Visible glitch in split bars after adjusting
!! ACDSee would hang when decoding truncated IFF images
!! Viewer title bar did not update after a rename or after a Remove All command
!! Auto-refresh into sorted position was not working correctly
!! Browser did not always detect file description changes made in the Viewer
!! Sort mechanism was ignoring ‘-‘ and ‘’’ characters
!! "Browse with ACDSee" shell command appeared in non-file folders such as Recycle Bin and My 

Computer
!! Colour component alignment problem with non-interleaved PCX images
!! Various auto-refresh bugs
!! Double-update flicker problem when switching images in Viewer in auto-zoom
!! Preferred window size was saved incorrectly when flipping out of Full-Screen mode
!! Preview image did not appear when set to be to the left of the file list and the folder tree was turned 

off
!! Crash when converting 24bpp images when running in 256 colours
!! new OS/2 bitmaps were not read correctly
!! Glitch in the rightmost 8 pixels of some 2-colour GIF images
!! Preview in progress was unnecessarily cancelled and restarted during an auto-refresh event
!! File being decoded in viewer could not be renamed
!! File list filtering was not working in Browser
!! Subfolders were not updated when a parent folder was renamed in the folder tree
!! GIF dimensions were not interpreted correctly for some images
!! Various glitches with randomized slide shows
!! Fixed a bug displaying interlaced GIF images with only 2 rows
!! Fixed bug that made Rename button on MCReplace dialog skip file if user had skipped a previous 

image in the same move/copy operation
!! Fixed bug that refreshed the file list unnecessarily when deleting a file with auto-refresh, read image 

headers and save image info in desription options on
!! Fixed problem with wallpaper not being updated in WinNT 4.0 and Memphis
!! Fixed problem reading PSD subtypes BITMAP and LAB, and those with extra channels
!! Fixed problem reading IFF images with masking==mskHasTransparentColor
!! Fixed problem handling short (8.3) filenames passed via DDE or on command-line when the "View 

All" option was turned on

Changes since version 2.0
+ Support for Electronic Arts Interchange File Format (IFF)
+ Support for Adobe PhotoShop Documents (PSD)
+ Confirm replace dialog now shows source and destination images for comparison
+ Print Setup options
+ Added Show Next and Previous Slide show Image commands to Viewer
+ Can now be started in Viewer mode with no images using the /v option
+ Options to show folders and non-image files in thumbnail view mode
+ Option to bypass recycle bin by default
+ Option to disable GIF animation



+ Option to allow Auto-refresh to be turned off
+ Option to automatically exit Viewer after deleting/moving the first
+ Options to disable Browser, File-Ops, Options, Options-Save, Wallpaper and Print features
+ Added middle or left+right mouse button support for toggling full-screen mode
+ Web Page command in Help menus
+ Help tips for menu items
o "View all" option now applies to File|Open Viewer command
o Improved document icons
o The remove wallpaper command now restores the original wallpaper, if any
o Changed thumbnail code to use DIBs when possible
o Changed left mouse button double click in viewer to switch to Browser mode
o Changed progress indicator in Browser so it doesn't cover up the status bar information
o Re-optimized updating of File List when files are deleted/moved from Viewer
o Enhanced refreshing of folder tree
o Changed to format numbers (e.g., file sizes) according to locale prefs
o Changed Viewer to exit when the last image is moved to another folder.
o Changed "confirm deletion" option to "don't confirm" 
o Added help button to registration dialog box
o Modified registration-nag image counter to include thumbnail images
o Changed non-system icon scheme to provide image type-specific icons
o Drives in file list auto-refresh when CD-ROM is inserted or removed
o Show Preview option in Viewer's Open dialog box is now saved and restored
!! Fixed enabling/disabling of buttons and menu command in Viewer
!! Fixed auto-window-size bug when the system tray was placed at the top or left hand size of the 

screen
!! Fixed bug which caused the slide show to stop when a bad image was encountered
!! Fixed bug with "phantom" ACDSee on task bar
!! Fixed a bug which caused file descriptions with extended characters to be displayed incorrectly
!! Fixed problem where not all thumbnails in a large folder could be created
!! Fixed a bug which occasionally caused a crash when dragging and dropping
!! Fixed animated GIF support to work better with images whose first frame is smaller than the    entire 

overall animation dimensions
!! Delayed Browser auto-refresh while in Viewer mode until the Browser is returned to
!! Browser's View menu items are now checked/unchecked properly
!! Fixed bug which prevented creating shortcuts to drives
!! Fixed a few bugs with file associations
!! Fixed a bug which (when Folder Tree is hidden) caused some drives not to appear in the file list 

sometimes
!! Fixed a bug which caused a refresh after deleting a file and "cache image headers" option is on
!! Hidden folders are no longer shown in the folder tree if the "show hidden files" is not turned on
!! Fixed bug which could cause the entire registry to be deleted if removing file associations from the 

options dialog
!! Fixed bug which caused a divide by zero exception when generating a thumbnail for a 1281x1 image
!! Fixed problem with long delay when drag-moving files out of a large folder
!! Fixed a nasty bug with “Set File Associations…” which could cause the registry to become corrupt 

Changes since version 1.0
+ support for animated GIF images
+ support for Windows Metafiles (.WMF)
+ folder tree pane
+ shortcuts pane
+ thumbnail file list view mode
+ image format conversion
+ drag and drop file management
+ automatic file list refreshing
+ integrated tabbed options dialog



+ added option to use device-dependent bitmaps
+ Open, Close and Close All commands in Viewer
+ Rename and Describe commands in Viewer
+ menu bars
+ support for Microsoft IntelliMouse
+ options to show/hide Browser toolbar, status bar, menu, etc.
+ option to show/hide Viewer menu
+ auto-zoom feature
+ auto-zoom reset option
+ option to hide mouse cursor in full-screen mode
+ option to save/restore Browser window size and position
+ dither mode for preview image is configurable
+ option to add or replace Viewer image list with dropped files
+ option to expand auto-sized Viewer window to the right and down rather than centered
+ snap cursor to buttons feature
+ preview area can be configured to appear on the left, on the bottom, or on the right
+ different icons for each supported file type
+ "New folder" command to create new folders
+ Associated file types can be easily set within the application
+ "Show gridlines" and "Full row select" file list options
+ Windows NT 3.51 is no longer supported
o faster image panning
o the preview is automatically reloaded when the preview area is resized (when auto-preview option is 

on)
o the file list rather than the preview window is resized when the window is resized
o significantly faster scrolling performance with some video drivers
o reorganized status bar information
o increased maximum slide show delay to 1 day
o new 256 colour program icons
!! fixed bug which caused some PCD images to be displayed topsy-turvy
!! fixed bug which caused a crash when displaying very long file descriptions
!! fixed bug where a new incoming image reset the slide show sequence mode to Forward mode
!! fixed bugs which caused some TGA images to be read incorrectly
!! fixed colourmap problem with some 256-colour PCX images



Starting the program

Starting in browser mode
You can start ACDSee in browser mode by clicking on the corresponding icon on the Start Menu. You 
will be presented with the image browser window where you can browse your system.

Starting in viewing mode
You can start ACDSee in viewer mode by clicking on the corresponding icon on the Start Menu.    You 
will be presented with a window where you can drop files for viewing, or use the File|Open command to 
add images to the view list.

Launching from another application
You can also start ACDSee from the Explorer by just double clicking on an image file.    Certain other 
programs, such as Internet applications, can also run ACDSee automatically for you as you receive 
images.    By default, a new ACDSee instance (i.e., window) is started for each image viewed.    You can
have all images viewed in the same window by changing the Startup option in the Miscellaneous 
options page.

Command line arguments (startup parameters)

Default behaviour (no arguments)
When no command line arguments are given, ACDSee starts in Browser mode in the default folder.

Specifying images to view
You can supply one or more image files as the command line arguments to ACDSee.    You can even 
use wildcards:

e.g., acdsee32 c:\images\*.jpg - start ACDSee and have it view all the .JPG files in the c:\
images folder.    

Note: if any file name includes spaces, you must enclose it in quotation marks:
e.g., acdsee32 “Metal Links.bmp”
e.g., acdsee32    “C:\My Pictures\Spot.psd” D:\Downloads\*.jpg

Browsing a particular folder
You may specify a particular folder to Browse as the command-line argument:

e.g. acdsee32 c:\images\ would start the ACDSee Browser in the c:\images folder.

Starting in Viewer mode (with no images)
You can start ACDSee in Viewer mode without an image by adding a “/v” to the command line:

e.g. acdsee32 /v

Printing
You can use ACDSee to print one or more images and exit by added a “/p” to the command line:

e.g., acdsee32    /p “C:\My Pictures\Spot.psd” “D:\Downloads\*.jpg”



Browsing
ACDSee’s image browser provides you with much of the functionality of Windows 95 Explorer.    In 
addition to managing your files, you can perform commands on image files.

Navigation
You can navigate through your file system by clicking on folders  and drives 

· to open a folder or a drive, double click on the icon
· to move up one folder, double-click on the folder  labeled “..”, or click the 

 button on the toolbar
· the path for the current folder you are inside is shown in the box just below the tool bar

File List View Mode
To change the way files are displayed, click on one of the following:

 view image files as thumbnails

 view files in rows of large icons

 view files in rows of small icons

 view files in columns of small icons

 view files as small icons with details

Note: to view thumbnails in 256 colour mode, you need to have a recent version of commctrl.dll (such 
as the version that comes with Windows NT 4.0 or Internet Explorer 3.0)

File management
By selecting files, you may perform various commands on them:

 copy to another folder

 move to another folder

 delete

 rename

 edit description

You can also move, copy or create shortcuts to files using the same drag-and-drop and cut-and-paste 
methods used in Windows Explorer.    Note:    if you drop or paste files outside of ACDSee (e.g., to 
Explorer or the desktop) then the corresponding file descriptions will not be copied.

The Shortcuts Pane
To turn on the shortcuts pane, selection View | Shortcuts from the menu (or press Ctrl+Shift+S).    Once 
visible, you can drag folders into the preview area and drop them there.    A shortcut to the folder will 
appear.    You can double-click on a shortcut folder to browse the contents of that folder.    You can also 
drop files onto the shortcut folders to copy, move, or create shortcuts to the files.

Image Commands
The following commands can be used on image files

 preview image

 view image(s)



 set desktop wallpaper to image

 print image(s)

· To select more than one file at a time, hold down the Ctrl or Shift key while selecting the icons.    
Or press Ctrl+A to select all files.

· If you want to perform a slide show, it is OK to select both image and non-image files.    The files 
which are not images will simply be ignored.

· You can also bring up a context menu by clicking on an icon with the secondary mouse button.    
· Other context menus are available by clicking with the secondary mouse button on the file list 

background area, file list header buttons, and preview area
· You easily change the way files are sorted

Preview Area
This is where image previews appear.    You can adjust the relative amount of room available to the file 
list and the preview area by dragging the split bar [a thin horizontal or vertical bar located just below or 
beside the file list] up or down.    You can also choose to have the preview area appear to the left of, 
blow, or to the right of the file list.    To do this, click on the split bar with the alternate mouse button and 
select one of the choices under Preview Position from the pop-up menu.

Options
· You can set various options which control how characteristics of the image browser by clicking on

the  button, or by selecting the commands under the View menu.



Viewing images
Once you have selected one or more images for viewing, ACDSee’s viewing window is opened.    Here 
you view a list of images, one image at a time.

Navigation
If you selected multiple images for viewing,    then you can use the  and 

 buttons to navigate to the previous and next images in the list.    You can also use the Page Up, Page 
Down, Home and End keys to navigate.    If you have the Microsoft IntelliMouse, you can turn the wheel 
while holding down Shift to flip through the images in the list.    

For images containing multiple pages, the first page is shown.    To view other pages, use the  and 

 buttons.    (These buttons are only visible while viewing a multi-page image).    By holding down the 
Shift key, you can also use the same keyboard and Intellimouse shortcuts listed above to flip pages.

Slide Show
Or you can click the  button to have ACDSee automatically flip from image to image every few 
seconds [a slide show]. Clicking on 

 again will stop the slide show. The delay between flipping, along with other slide show options, can 
be set in the options dialog.

Magnification (Zooming)
You can enlarge or reduce the apparent size of the image by clicking on the  and 

 buttons.    Alternatively, you may press the + and - keys on the numeric keypad.    If you have the 
Microsoft IntelliMouse, you can change the zoom level by turning the wheel.    Additional zoom commands
are available under the View | Zoom menu.

Scrolling (Panning)
If the image is so large that it is not fully visible within the window, you can scroll the image using the 
cursor keys or by dragging the image with the mouse.    When using the cursor keys, you can hold down
the shift key to scroll slowly, and the ctrl key to scroll quickly.

Other commands
Here are some other commands which you will find useful:

 switch to browser

 print image

 set desktop wallpaper image

 copy file to another folder

 move file to another folder

 delete file

 change file name

 edit file description

 set viewer options

· You can also bring up a menu of commands by clicking in the view area with the secondary 
mouse button



· pressing Ctrl+F will toggle full-screen display mode 
· in full screen mode, you can press and hold down the b, t and m keys to temporarily show the 

status bar, the tool bar and the menu, respectively
· The system menu contains an “Always on top” window option



Browser keyboard shortcuts
Keyboard shortcuts
Key Function
Backspace Move up one folder.
F5 Refresh the list of files.
Ctrl + V Preview the selected image.
Enter File list  - View the selected files.    Shift for new window.

Path box  - Browse the specified folder
Shortcuts list  - Browse the folder the shortcut refers to

Ctrl + S Slide show all.
Ctrl + Shift + S Slide show all, including subfolders.
Ctrl + G Generate ASCII file listing
Ctrl + P Print the selected images.
Ctrl + W Set desktop wallpaper.    

Shift key: tile wallpaper.
Alt + W Restore original desktop wallpaper.
Ctrl + C Copy selection to clipboard.
Ctrl + X Cut selection to clipboard.
Ctrl + V Paste from clipboard.
Alt + C Copy files to another folder.
Alt + M Move files to another folder.
DEL Delete.    

Shift key: bypass recycle bin. 
Ctrl key: bypass confirmation.

F2 or Ctrl + R Rename.
Ctrl + D Describe.
Ctrl + O Options.
F1 Help.
Ctrl + L Shell open.    

Shift key: specify application to open with.
Ctrl + E Shell edit.    

Shift key: specify application to edit with.
F8 - F12 Change view to Thumbnails, Large Icon, Small Icon, List or Details.
Alt + X Quit.
Ctrl + Num ‘+’ Automatically size columns in detail view.
Ctrl + A Select all files
Ctrl + I Toggle the display of image files only.
Num 0-6 Sort by extension, name, size, type, date, image dimensions or description.
Num +/- Sort in forward/reverse direction
Num * Toggle the preview size between full-size and auto-size
Ctrl + [Num 2-6] Toggle the display of size, type, date, image dimensions or description in detail view.
Tab Move between the path box, folder tree, file list and shortcuts list
Ctrl Hold down Ctrl key to select multiple files.    

Press Space key or click with mouse to tag individual files.
Shift + Esc Minimize window.
Ctrl + Shift + T,B,M,D,F,Q,P Toggle display of toolbar, status bar, current folder path box, menu bar, folder tree, shortcuts and

preview, respectively
Ctrl + Shift + Cursor Left, 
Down, Right

Set preview position to the left, below, and to the right of the file list, respectively.

Note: some    commands allow the Alt key to be substituted for the Ctrl key, if you prefer to use the Alt 
modifier.



Viewer keyboard and mouse shortcuts
Keyboard shortcuts
Key Function
 Esc Return to the browser or quit.
Enter Switch to the browser.
Insert Add images to view list.
Ctrl + Q Remove current image from the view list.
Ctrl + Shift + Q Remove all images from the view list.
Page Up, Page Down, 
Home, End

Previous, Next, First, and Last image in view list, resp.    
Shift key: navigate pages within a multi-page images.

Ctrl + S Stop or resume timed slide show.
Space/Backspace Show next/previous image in slide show sequence.
F5 Reload.
Num - or “-“ Zoom out.
Num + or “=” Zoom in.
Num * Zoom to fit window/screen
Num / Zoom 100%
Ctrl + P Print.
Ctrl + C Copy to.
Ctrl + M Move to.
F2 Rename.
Ctrl + D Describe.
DEL Delete.    

Shift key: bypass recycle bin. 
Ctrl key: bypass confirmation.

Ctrl + V Paste files on the clipboard into the image list.
Ctrl + W Set the selected image as the desktop wallpaper.

Shift key: tile wallpaper.
Alt + W Remove original desktop wallpaper.
Ctrl + L Shell open.    

Shift key: specify application to open with.
Ctrl + E Shell edit.    

Shift key: specify application to edit with.
Ctrl + O Options.
F1 Help.
Alt + X Quit.
Ctrl + Shift + T,B,M Toggle display of resp. toolbar, status bar and menu bar.
T, B, M Temporarily display resp. toolbar, status bar and menu bar.
Ctrl + F Toggle full screen mode.
Shift + Esc Minimize window.
Cursor keys Scroll image.    

Shift key: scroll slower
Ctrl key: scroll faster.

Note: some    commands allow the Alt key to be substituted for the Ctrl key, if you prefer to use the Alt 
modifier.

Mouse shortcuts
Left button drag Pan image in direction of drag.
Left button double-click Switch to the Browser.
Right button click Context menu.
Left + Right button click Toggle full screen mode.
Middle button click Toggle full screen mode.
Wheel up Show previous image in view list.



Wheel down Show next image in view list.
Shift + wheel up Show previous page of a multi-page image.
Shift + wheel down Show next page of a multi-page image.
Ctrl + wheel up Zoom in.
Ctrl + wheel down Zoom out.
Wheel click Toggle full-screen mode.

How to run a slide show
1. In the browser, select several image files.    (Hold down Ctrl to make a multiple selection)

2. Click on .    The image viewer window is brought up.

3. Click on  to start the slide show.    Click again to stop.

· In the Browser, you can press Ctrl+S or select Tools | Slide show from the menu to add all images
from the current folder to the slide show image list.    Select Slide show recursive to include 
images in subfolders as well.    The Slide show and Slide show recursive commands are also 
available form the context menu for items in the folder tree, file list and shortcut list.

· By checking the Viewer | View all images in folder option, you need only select one image to 
perform a slide show of all images in the folder, beginning with the selected image.

· From the Viewer, you can add images to the slide show list by using the File | Open menu 
command, or by dragging files and dropping them on the window.    You can remove an image 
from the slide show list by using the File | Close menu command.    Use File | Close all to remove 
all images at once.

· The slide show will automatically stop when you use  and 

, or when you minimize the window.



How to view an image full-screen
In full-screen mode, the window borders, menu bar, status bar and tool bar are hidden and the window 
is expanded to fill the screen, so that only the image is visible on your monitor.

To enter full-screen mode:

1. Bring up the image in the Viewer
2. Press Ctrl+F or double click anywhere on the image
3. The tool bar buttons are hidden, but you can still access the commands via shortcut keys or by 

clicking with mouse button 2
4. To return to the window, press Ctrl+F or double click again

· You can also toggle between full-screen and normal modes by clicking and holding down the 
primary mouse button while clicking with the alternate mouse button.

· in full screen mode, you can press and hold down the b, t and m keys to temporarily show the 
status bar, the tool bar and the menu, respectively



How to set the desktop wallpaper
1. Bring up an image in the Viewer, or select one image in the browser

2. Click on 

3. Hold down shift when you click on  to have the wallpaper tiled rather than centered

4. To restore the original wallpaper, hold down Alt and click on 

You can also set the wallpaper using the Wallpaper menu commands under the Tools menu



How to manage files
Copying

1. Select one or more files in the browser

2. Click on 
3. Select a destination path from the list, or type in a new one, or click on Browse…

or:
Right click on the selected file(s), drag and drop onto a folder in the folder tree, file list, or 
shortcuts pane.    Select Copy Here from the popup menu that is displayed.    You can also drop 
onto or into any folder in Explorer, but file descriptions will not be copied in this case.

Moving
1. Select one or more files in the browser

2. Click on 
3. Select a destination path from the list, or type in a new one, or click on Browse…

or:
Right click on the selected file(s), drag and drop onto a folder in the folder tree, file list, or 
shortcuts pane.    Select Move Here from the popup menu that is displayed.    You can also drop 
onto or into any folder in Explorer, but file descriptions will be lost  in this case!

Deleting
1. Select one or more files or empty folders in the browser

2. Click on  or hit Delete.    A confirmation box appears
3. Click OK to delete the file, or Cancel to stop
4. You can hold down the Ctrl to bypass the confirmation box, and Shift to bypass the recycle bin

Renaming
1. Select a file or folder in the browser

2. Click on  or the file’s name.    The name will become editable.
3. Type in the new name and hit Enter

Describing
1. Select one or more files or folders in the browser

2. Click on  
3. Enter the file description and click on OK



How to print images
From the browser

1. Select one or more image files

2. Click on 
3. Follow the instructions in the print dialogs
4. The selected images will be printed, one per page

From the viewing window

1. Click on 
2. Follow the instructions in the print dialogs
3. The image will be printed

From the command line
Enter “/p” as the first command-line argument, followed by the list of images to print, each enclosed in
quotes and separated by spaces.

e.g., acdsee32 /p “C:\My Pictures\Spot.psd” “D:\Downloads\*.jpg”



How to work with file descriptions
File descriptions are pieces of text (up to about 200 characters) which can be used to describe a file (or 
folder) in more detail than is practical with the file name alone.    File descriptions are used by a few 
other application programs but are not supported directly by Windows 95.

The file descriptions are stored in a hidden file called “descript.ion”.    There is one such file for each 
folder.    If you move, copy or delete the file with ACDSee or any other program which supports file 
descriptions, its description will go with it.    Unfortunately, if you use other programs such as Explorer 
which do not support file descriptions, then descriptions are lost when files are moved or copied.    

Files which reside on read-only disks such as CD-ROM’s cannot be described.

In the browser, file descriptions appear in the rightmost column in detail view.

To enter or edit file descriptions
1. Select one or more files or folders in the browser

2. Click on  
3. Enter the file description.    If you check the “apply to all” box, then the same file description will be
applied to all selected files.
4. Click on OK



How to set options

1. Click on 
2. An option dialog box comes up.    
3. You may right click on an option to get information about the option.
4. Set the options
5. Click on OK to save the options.



How to read image files with nonstandard filename extensions
By default, ACDSee assumes that all image files end with the conventional file extensions (.BMP, .JPG, 
etc.)    If an image file has a different extension then ACDSee will think that it is not an image.

You can change this behavior so that ACDSee peeks at every file and determines whether or not it is an
image:

1. From the browser, click on .
2. In the options dialog box, set the Read image headers option to Always or Only on fixed disks, 
and then click on OK.

Now whenever you enter a folder, you will see ACDSee checking the files.    A progress bar at the 
bottom of the window gives you an indication on how it is doing.    While the files are being checked, you
can still select files, preview images, etc.    To stop checking files, however, hit ESC or click on the 
progress bar.

When ACDSee checks the files, it also retrieves the image format and dimensions which are displayed 
in detail view.

You can get ACDSee to cache the file header information so that it only needs to check the files once 
instead of every time you enter the folder.    The information is stored in a hidden file called 
“descript.ion”.    

To have ACDSee cache image header information,

1. From the browser, click on .
2. In the options dialog box, check the Cache image dimensions option and then click on OK.



How to run ACDSee automatically from other programs
Often it is convenient to use ACDSee as a “helper” application for viewing images from other 
applications.    When you installed ACDSee, you were presented with a list of file types which could be 
assigned to ACDSee.    This list was automatically registered for you.    

To assign a new type to ACDSee:

1. Click on 
2. An option dialog box comes up.    
3. Click on the Miscellaneous tab
4. Click on the File Associations… button
5. Check off the various file types you would like to associate with ACDSee
6. Click on OK



How to control the size and position of the viewing window
By default, the viewing window is automatically sized to fit the image displayed, and it is positioned in 
the center of the screen.

To have ACDSee position the window centered somewhere else:
· Position the window so that its center is where you want it

To have ACDSee always use a specific size and position:
1. Position the window so that its center is where you want it

2. Click on .    The options dialog appears.
3. Click on the Viewer tab and Uncheck the Change window size to fit image option

To have ACDSee view in full-screen mode by default:

1. Click on .    The options dialog appears.
2. Click on the Viewer tab and check the Full-screen option.
3. Click on OK.



How to change the way files are sorted
Clicking on the column headers

You can sort on the data in a column by clicking on the corresponding list header button above the file 
list.    Clicking on the same column repeatedly will alternate between forward and reverse sorting.    A ‘+’ 
or ‘-’ will appear next to the column currently being sorted on.

Menu
Select the View menu, and then Arrange Icons, and select the desired sort method.

Context menu
You can click with the alternate mouse button in the file list window in an area not containing a file name
or icon to bring up a context menu with commands applicable to the file list.    From this context menu 
you can change the sort method and direction.

Shortcut Keys
You can press any of the keys 0 through 6 on the numeric keypad (you must have Num Lock turned on)
to sort by file extension, name, size, type, date, image dimensions or description, respectively.

Note that the latter two methods work even if the corresponding column is not visible, or if the list is not 
in detail view.



How to show/hide file list columns
Context menu

You can click with the alternate mouse in the area containing the file list column headers to bring up a 
context menu which allows you to make each column visible or invisible (the name column is always 
visible).    

Menu
Select the View menu, and then Show Columns, and select the column you wish to show or hide.

Shortcut keys
You can press any of the keys 1 through 6 on the numeric keypad (you must have Num Lock turned on)
while holding down the Ctrl key to toggle the display of the size, type, date, image dimensions and 
description columns, respectively.



How to launch document files
Like Explorer, ACDSee will launch the default application associated with a file when you double-click 
on it, or select it and press Enter.    

Note:    If the file is an image which can be viewed by ACDSee then it will be opened within ACDSee 
rather than launched.    To launch the default associated application instead, press Ctrl+L or select 
“Shell Open” from the context menu.

The Open and Edit file actions
ACDSee allows you to set two actions for each file type.    The “open” action is the default action which 
is used by Explorer and other programs.    The additional “edit” action allows you to set up a secondary 
command.    This is meant to allow you to invoke a special program to edit graphics with, but you can 
use it however you like.

Invoking file actions on a file
To invoke any action defined for a file (i.e., “launch it”), click on the file with the alternate mouse button 
and select the action from the context menu.    These actions are labeled “Shell open”, “Shell edit”, etc. 
in the menu.    You can invoke the Open and Edit actions directly by pressing Ctrl+L and Ctrl+E, 
respectively.

Setting the Open and Edit actions for a file type
Select a file, bring up its context menu, and select Open with... or Edit with... from the Associate 
submenu.    Or just hold down Shift while pressing Ctrl+L or Ctrl+E.    A dialog box pops up allowing you 
to select an application to handle the action.    Check the box at the bottom of the dialog to make the 
association permanent, or clear the box to launch the file with the given application without saving the 
new association.



How to convert images to another format 
1. Select an image in the Browser.
2. Select Convert from the Tools menu.
3. Choose the desired output format.



Tip: Viewing multiple images simultaneously
ACDSee only allows you to view one image at a time.    To get around this restriction, you need to run 
two copies of ACDSee.

To accomplish this easily from the browser,

1. Select an image

2. Hold down Shift while you click on 
3. A new copy of ACDSee is started in viewer mode and the image is loaded
4. Go back to the original copy of ACDSee and select a different file
5. Repeat from step 2

If you have associated the relevant file types to ACDSee, you can also view an image in a new window 
as follows:

1. Select an image
2. press Ctrl+L (Launch).

To close the extra viewer windows, you can just hit ESC



Tip: Optimizing image display quality
If you have a 256 or 64k (high colour) display, 24-bit images with 16 million colours must be processed 
by ACDSee before being displayed to reduce the number of colours used.      This two-stage process is 
called quantization and dithering.    By selecting different quantization and dithering methods, you can
trade off image quality against decoding speed.    That is, higher quality output will cost you some extra 
decoding time.

256 Colour Displays
For 256 colour displays, the available quantization and dithering methods are:

1-pass ordered Fastest, reasonable quality output. (default)
1-pass Floyd-
Steinberg

Somewhat slower, reasonable quality 
output.

2-pass Floyd-
Steinberg

Much slower, good quality output.

In 2-pass Floyd-Steinberg dithering, the image is decoded in two passes.    In the first pass, ACDSee 
decodes the image and determines the optimal colour palette.        While this is happening, the image is 
displayed using the 1-pass ordered method.    In the second pass, ACDSee dithers the image using the 
optimal palette and, at the end, displays the image.
This method produces output that is usually very high quality, but is quite a bit slower than the single 
pass methods.

High Colour Displays
For high colour displays, the available quantization and dithering methods are:

No dithering Fastest, high quality output.
Ordered A little slower, very high quality output. 

(default)

For many images, there is very little visible difference between these two methods.    The superior 
output of the ordered dithering method is most noticeable in computer generated images.    However, 
the ordered dithering is so fast that it is usually best to use this option.

True Colour Displays
For true colour displays, ACDSee gives you the highest quality output possible.    No quantization or 
dithering required!



Tip: Starting ACDSee’s Browser in a particular folder
To start ACDSee in a particular folder, just include its path on ACDSee’s command line.

Example:

1. Using Explorer, create a shortcut to ACDSee.exe on your desktop.
2. Select the shortcut icon and hit Alt+Enter to bring up its properties
3. Click on the Shortcut tab
4. In the Target box, add a space after the path to ACDSee32.exe and then type in the path for 

ACDSee to start in.    e.g., it might read, C:\acdsee32\acdsee32.exe c:\win95
5. Click on OK



Tip: Opening images with external applications from the browser
Sometimes you may find it convenient to use ACDSee to locate an image and then open it with some 
other application (for editing, for example).    You can define an edit action for your image’s file type, 
whereupon you may launch the external application by selecting Shell edit from the context menu in 
ACDSee (or just hit Ctrl+E).

If there is no edit action associated with the file type, then selecting Shell edit with from the context 
menu (or Ctrl+E) will allow you to easily define one.



Tip: Caching the image header information
If you are using the Read Image Headers option then it may take a while for ACDSee to check all the 
files when you enter a folder. ACDSee can skip this process and still let you view images with non-
standard extensions and pre-fetch the image header information.    It does this by caching the 
information in a hidden file called “descript.ion” (the same file that descriptions go into) so that it only 
needs to check each file once and then never again [until the file is modified, that is].

To have ACDSee cache image header information,

1. From the browser, click on .
2. In the options dialog box, click on the File List tab, check the Cache image dimensions option and
then click on OK.



Tip: Using a single window when used as a helper application
Normally, ACDSee starts a new program instance each time an external application calls it to view an 
image.    Normally if the external application calls ACDSee several times, several viewer windows are 
thus generated.    You can instead have ACDSee use the same window for all images, thereby reducing 
the number of opened windows.

To configure ACDSee to run in a single window:

1. From the viewing window, click on .
2. In the options dialog box, locate the Startup option group.
3. Click on Replace image list or Add to image list

Replace image list causes ACDSee to close all images in the current file list, thereby replacing them 
with the new image.    Add to image list, on the other hand, simply adds the new files to the list, allowing 
you to navigate back to previously viewed images.

Important:
The single-window feature will only work when ACDSee is invoked via DDE commands.    ACDSee 
registers itself as a DDE server in the system registry for the appropriate file extensions when you 
install it, or when you ACDSee to make an association to itself with the Open with… command, or the 
File Associations dialog under Options. 

If you make your associations to ACDSee with another program such as Explorer, they will not be set 
up correctly!



Tip: Using the shortcuts pane to speed up browsing and file 
management

The shortcuts pane contains a number of shortcuts to folders on your system.    You can quicly access 
frequently used folders by creating shortcuts to them here.

Adding a folder to the shortcuts pane
1. Find the folder you want to add in the File List, Folder Tree, or Explorer.
2. Drag the folder and drop it on an empty area of the shortcuts pane.

Browsing a folder in the shortcuts pane
1. Double-click on the shortcut, or
2. Click on the shortcut with the alternate mouse button and select Browse from the context menu.

Copying or Moving files into a folder in the shortcuts pane
1. Select the file(s).
2. Using the alternate mouse button, drag them into the shortcuts pane and drop them on the 

desired destination folder.
3. Select Move, Copy or Create shortcut(s) from the context menu

You can also drag with the primary mouse button.    The action that will be taken (Copy, Move, Shortcut)
is indicated by the mouse cursor shape.    Use Shift and Ctrl to select alternative operations.

Renaming and Deleting shortcuts
1. Select a shortcut.
2. Press F2 to rename or Delete to delete, or
3. Click on the shortcut with the alternate mouse button and select Rename or Delete from the 

context menu.



What is registration?
ACDSee is "Shareware".    This means that we have made the software available to you for free 
evaluation.    You are entitled to evaluate the software for up to 30 days without obligation to pay.    After 
30 days, if you decide to keep the software, you must register your copy with us for a small fee.

Shareware (non-registered) ACDSee is a "full-featured" release.    This means that the same capabilities
available in the registered software are present in the non-registered software.    This allows you to try 
out all the features in ACDSee to confirm that they work to your satisfaction.    In fact, the non-registered
software includes a bonus feature - the shareware nag box.    This is an added incentive for users to 
register the software rather than continue using it indefinitely without paying.

· Why should I register?
· How can I register?



Why should I register?
For many people, the most pressing reason to register is to get rid of the annoying nag box which pops 
up at the most inconvenient times.

But besides this, registration entitles you free technical support and minor upgrades to the software.    
Registration may also entitle you to discounts on new software releases from ACD Systems.    We will 
also send you information bulletins by email to let you know about what’s happening with ACD Systems’
shareware products.

Finally, by registering the software, you provide us with the resources and incentive to support the 
software with updates and to develop additional quality shareware products in the future.



How can I register?
The registration fee for ACDSee 32 is $30 US.    

Registered users of ACDSee for Windows 3.x and PicaView can register ACDSee 32 for a discounted 
fee.    See http://www.acdsystems.com for more information, or call 1-800-414-2237.

If you are part of a business and wish to use several copies of ACDSee within your company, greatly 
reduced site licensing rates are also available.    For more information 

For your convenience and protection, we provide the following secure methods of registration:
· Telephone
· FAX
· Internet
· CompuServe
· Postal mail

See also:

ACDSee order form

How to unlock the software

Licensing agreement



Unlocking the software
One you have registered ACDSee with ACD Systems, Ltd., you will receive a registration code that you 
can use to unlock the software:

1. Bring up the Registration Dialog selecting Register from the Tools menu.
2. Enter your name in the registration dialog.    
3. A pre-registration code appears.    This is a numerical encoding of your name.    ACD Systems 

may require you to state this number, along with the product ID, if you register by telephone.
4. Enter your registration code in the box provided.
5. Click on OK

If you entered your name and registration code correctly, you will be thanked and the software will 
unlock itself.    Otherwise you will have to try again.



Getting a multiple-user site license
If your company or institution is interested in licensing ACDSee for several users, you can save a lot of 
money by purchasing a site license.    The program is licensed to your company for use at a single site 
with the agreed upon number of users.

The pricing schedule for site licenses can be found on the WWW at:
http://www.acdsystems.com

If you are interested in arranging a site license, please give us a call toll-free at 1-800-414-2237, fax 1-
800-819-2207, or e-mail acdshare@acdsystems.com.



ACDSee 32 Image Viewer Order Form

USA Canada
ACD Systems, Inc. ACD Systems, Ltd.
177 Telegraph Rd.    #591      PO Box 730
Bellingham, WA USA    98226 Victoria, BC Canada V8W 2P9

North America International
Phone: 1 (800) 414 2237 Phone: 1 (250) 382-4701
Fax: 1 (800) 819 2207 Fax: 1 (250) 382-7099

Date____________________________

Name__________________________________________________________________________________________

Company____________________________________________________ Phone___________________________

                                          
Street_______________________________________________________ FAX____________________________

City _________________________ State/Province______ Country____________________  Zip/PC______________

Email______________________@__________________________________________________________________

                                All Amounts Are United States Dollars

License: Single user license =          $30.00

Diskette (optional) shipping and handling
U.S. & Canada ___ @ $4.95 =__________
Other Areas ___ @ $11.00 =__________

Total  (US funds only) =__________

Method of payment:    Cheque___  Money order___  Mastercard___ VISA___

Name exactly as on credit card_____________________________________________________________________

Card number____________________________________________________________________________________

Exp. Date_____________ Signature________________________________________________________________



Registering by telephone
To register by phone, call 1 (800) 414 2237.    In Canada, call 1 (800) 563 7138.
Or, where international 800 service is unavailable, please call 1 (250) 382 4701.

Operators are standing by to take your order 24 hours a day, every day of the week.

Please have your VISA or MasterCard ready when you place your call.

You may also need to provide your Pre-registration code.    To obtain your Pre-registration code, click on

, then click on Register…and enter your name in the box.    Your pre-registration code will appear in 
the box below.



Registering by FAX
1. print out and complete the supplied order formREGISTRATION_FORM
2. FAX the completed form to 1 (800) 819 2207 [outside North America: 1 (250) 382-7099]
3. we will send you your registration number via e-mail or post



Registering through CompuServe
If you are a member of the CompuServe Information Service, you may register via the Shareware 
Registration Database:

Important:    you cannot upgrade from ACDSee 16 for Windows 3.1 via CompuServe.    
Please call 1 (800) 414 2237 to upgrade.

1. log onto CompuServe
2. enter GO SWREG
3. follow the on-line instructions
4. enter the title ACDSee for the search criteria and then select Display Selected Titles
5. select ACDSee 32 for Windows 95/NT, click on Description and then follow the on-line 

instructions

Or you can use the following list of numbers to locate this and other ACD Systems products that can be 
registered via SWREG

PicaView 32 14209
PicaView NT 14208
PicaView 16 6115
ACDSee 16 4057
ACDSee 32 10146

Your registration information will be electronically mailed to your CompuServe account within a few 
business days.



Registering by postal mail
1. print out and complete the supplied order formREGISTRATION_FORM
2. send completed order form with your US funds cheque or money order to one of the addresses 

listed at the top of the order form

Your registration information will be sent to you via e-mail or post.



Registering by Internet
If you have a credit card, you can register via a secure Internet server at our web site:

http://www.acdsystems.com



Licensing details
1. Distribution

This shareware software may be freely distributed, provided that:

1. Such distribution includes only the original archive supplied by ACD Systems, Ltd.    You may not 
alter, delete or add any files in the distribution archive.

2. The distribution does not include a registration number.    In particular, you may not distribute a 
registered version of ACDSee.

3. No money is charged to the person receiving the software, beyond reasonable cost of packaging 
and other overhead.

For information about redistribution of ACDSee...
WWW: http://www.acdsystems.com
E-mail: acdshare@acdsystems.com 
Fax: 1 (800) 819 2207 (toll free)

2. License
By receiving and/or using ACD Systems software, you accept the following Evaluation and Registered 
User Agreement.    This agreement is a binding legal agreement between ACD Systems Ltd. and the 
purchasers, users or evaluators of ACD Systems' software and products.    If you do not intend to honor 
this agreement, remove all installed    ACD Systems software from your computer now.

3. Evaluation (Unregistered) and Registered User Agreement
You may evaluate the Shareware program for maximum of thirty calendar days, after which you must 
register the program with ACD Systems Ltd. or remove the software from your computer.    

You may allow other users to evaluate copies of the unregistered Shareware. All evaluation users are 
subject to the terms of this agreement.

The evaluator/user/buyer/owner is not allowed to attempt to reverse engineer, disassemble or 
decompile ACD Systems Software and products. 

ACD Systems name and any logo or graphics file that represents our software may not be used in any 
way to promote products developed with our software.    All parts of ACD Systems software and 
products are copyright protected.    No program, code, part, image, video clip, audio sample, text or 
computer generated sequence of images may be copied or used in any way by the user except as 
intended within the bounds of the single user program.

The evaluator/user/buyer/owner of ACD Systems software will indemnify, hold harmless, and defend 
ACD Systems against lawsuits, claims, costs associated with defense or accusations that result from 
the use of ACD Systems software. 
 
ACD Systems is not responsible for any damages whatsoever, including loss of information, interruption
of business, personal injury and/or any damage or consequential damage without limitation, incurred 
before, during or after the use of our products.    Our entire liability, without exception, is limited to the 
customers' reimbursement of the purchase price of the software (maximum being the suggested retail 
price as listed by ACD Systems) in exchange for the return of the product, all copies, registration papers
and manuals, and all materials that constitute a transfer of ownership from the customer back to ACD 
Systems.

Each registered copy of the ACD Systems software may be used in only one single location by one 



user.    Use of the software means that you have loaded the program and run it or have installed the 
program onto a computer.    If you install the software onto a multi-user platform or network, each and 
every individual user of the software must be registered separately.

You may make one copy of the registered software for backup purposes, providing you only have one 
copy installed on one computer being used by one person. If any person other than yourself uses ACD 
Systems' software registered in your name, regardless of whether it is at the same time or different 
times, then this agreement is being violated!    

The sale of and or distribution of registered copies of this software is strictly forbidden.    It is a violation 
of this agreement to loan, rent, lease, borrow, or transfer the use of registered copies of ACD Systems 
Software products.



Getting program updates
You may download ACDSee 32 from the following sources:

Internet WWW
http://www.acdsystems.com
http://www.acdnet.com
http://www.acdsys.com
http://www.acdvictoria.com

Internet FTP
ftp://ftp.acdsystems.com
ftp://ftp.servtech.com/pub/users/acdsys
ftp://ftp.islandnet.com/acd

Direct Modem Connection
(250)479-6253, N81, 9600-14.4k, login as acdsys



How to get technical support and contribute feedback
Technical Support

Registered users are entitled to technical support, should the need arise.    Please contacts us by email 
at acdshare@acdsystems.com or 74404,2711 on CompuServe..    If you do not have e-mail access, you
may telephone us at 1 (250) 382-4701.    Our office hours are Monday to Friday, 2 PM to 9 PM EST.

Feedback
If you have any comments or concerns about ACDSee please direct them to 
acdshare@acdsystems.com or 74404,2711 on CompuServe.    Your feedback is important to us in order
to get an idea of how to make ACDSee a better product for you.    Many of ACDSee’s features and 
significant portions of ACDSee’s interface have been heavily influenced by comments from users.    So if
you have a grand idea for a new feature, or a better way of doing something, please drop us a note.



Contacting ACD Systems

E-mail acdshare@acdsystems.com

WEB http://www.acdsystems.com
http://www.acdnet.com 
http://www.acdsys.com
http://www.acdvictoria.com

FTP ftp://ftp.acdsystems.com/pub
ftp://ftp.islandnet.com/acd
ftp://ftp.servtech.com/pub/users/acdsys

CompuServe 74404,2711

Telephone Support 1 (250) 382-4701 2 PM to 9 PM EST, Monday to Friday
Orders only 1 (800) 414 2237 24 hours a day, 7 days a week

FAX N. America 1 (800) 819 2207 
International 1 (250) 382-7099

Post USA ACD Systems, Inc.
177 Telegraph Rd    #591
Bellingham, WA, USA 98226

Canada ACD Systems, Ltd.
PO Box 730 
Victoria, BC, Canada V8W 2P9
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Hide all files that are not images readable by ACDSee.

Tip: you can also toggle this option with (CTRL+I)



Show files and folders that have the “hidden” attribute.



Show icons as they would appear in Explorer.      
Otherwise, a set of generic icons is used [faster]. 



Automatically adjust the widths of the columns in detail view to fit the contents of the file list.



Show a preview of each image as it is selected.

Tip: you can also set this option by clicking on the preview area with mouse button #2



Wait for a period of time (in 1/100ths of a second) after an image is selected before engaging the automatic preview.
+ increase to reduce sluggish response to image selection
- decrease to cause the preview to appear more rapidly



Sets the size of the preview image

Full full resolution
1/2 one half resolution
1/4 one quarter resolution
1/8 one eighth resolution
Auto variable - uses the largest resolution which fits in the available preview area

Tip: you can also set this option by clicking on the preview window with mouse button #2



Don’t ask for confirmation before files are deleted.      This option has no effect if the delete confirmation is turned off 
system-wide for the drive containing the file.

Tip: you can also bypass confirmation on an ad hoc basis by holding down the Shift key while you invoke the Delete 
command.



Delete files permanently, rather than moving them to the recycle bin.    This option has no effect if the recycle bin is 
turned off system-wide.

Tip: you can also bypass the recycle bin on an ad hoc basis by holding down the Ctrl key while you invoke the Delete
command.



Cache image information in a file called “descript.ion”. Information about the files in the current folder will be 
automatically saved to and recalled from this file rather than examining every file in the directory each time it is 
entered,    thus speeding up performance significantly.



Set the hidden attribute on descript.ion files.



Read and write file descriptions in Oem character set, converting to Ansi for display.    Otherwise, no conversion is 
performed.



Start up in the folder last accessed from the previous session.



Show the full path (folder + file name) of    the currently viewed image file.    Otherwise, only the file name is shown.



When a single image is selected and the View command is invoked, causes all images in the current folder to be 
viewed. Otherwise, only the selected image is accessible.

This option is useful for conveniently stepping through a directory of images in view mode.    

Note: When multiple files are selected in the Browser, normal operation ensues -- only the selected files are viewed



Causes the Viewer to exit after the first image displayed is deleted or moved.    If ACDSee was previously in Browser 
mode, it will return to Browser mode automatically after the last image in the view list has been deleted.



Sets the policy on whether files should be examined for image data.    

Never do not examine any files, ever
Always always examines all files
Only on fixed disks examine files on local hard drives only
Only on non-floppy and non-CDROM disks don’t examine files on A:\, B:\ or CD-ROM drives

When the Never setting is in effect, it is assumed that all files ending in an appropriate extension (.BMP, .JPG, etc.) 
are images files, and all other files are not.    In addition, image properties are not displayed until after each image is 
accessed by previewing it.    This is the fastest option because no files need to be opened for examination.

By contrast, the Always setting examines all files regardless of their extension.    This allows the detection of image 
files with non-standard extensions (e.g., older versions of Netscape ™ store cached image files with a .MOZ 
extension).    In addition, image properties are pre-fetched for all image files.    

Because all files must be examined every time a folder is entered, this option can cause a lot of disk access and 
cause sluggishness.    This is especially so when reading from slow-access removable media such as floppy, CD-
ROM and network drives.    The Only on fixed disks and Only on non-floppy and non-CDROM disks options are 
thus useful compromises.

Tip #1:  you can cancel the file examination process on an ad hoc basis by hitting (Escape) or clicking on the 
progress meter.

Tip #2:  you can optimize file examination tremendously by enabling the cache image info in descript.ion option.



Enter your full name here (as it appears on your credit card, if you are registering by credit card).
It must contain at least 5 letters.



This is your pre-registration code.    It is generated from your name.    ACD Systems may ask you for this number if 
you register by telephone.



This is the product ID number.    It identifies the product and version that you are registering.    ACD Systems may ask 
you for this number if you register by telephone.



This is the product ID number.    It identifies the product, version and unit that you are registering.    You can find it at 
the back of your manual.    ACD Systems may ask you for this number if you register by telephone.



Connects to the ACD Systems Internet Orders page using your Web browser.



Displays more information about the registration process.



Type in the registration code given to you by ACD Systems when you register.



Validates your registration information and unlocks the software



Closes the dialog box without validating your registration information.



Pre-load the next image in the list



Start a slide show automatically when more than one image is viewed



Specifies not to stop the slide show when the last image of a sequence is reached.



In a slide show, pause for this amount of time before showing the next image



In a slide show, don’t flip to the next image until it has finished loading [thus overriding the delay setting]



Order the presentation of images in a slide show from first to last



Order the presentation of images in a slide show from last to first



Order the presentation of images in a slide show in a random permutation



Use single pass quantization to 256 colours with ordered dithering to enhance the display of true colour and high 
colour images on a 256 colour display



Use single pass quantization to 256 colours with Floyd-Steinberg dithering to enhance the display of true colour and 
high colour images on a 256 colour display 



Use two pass quantization to 256 colours with ordered [pass 1] and Floyd-Steinberg [pass 2] dithering to enhance the
display of true colour and high colour images on a 256 colour display 



Do not use ordered dithering to enhance the display of true colour images on a high colour display.



Use ordered dithering to enhance the display of true colour images on a high colour display



Use single pass quantization to 256 colours with ordered dithering to enhance the display of true colour and high 
colour previews and thumbnails on a 256 colour display



Use single pass quantization to 256 colours with Floyd-Steinberg dithering to enhance the display of true colour and 
high colour previews and thumbnails on a 256 colour display 



Use two pass quantization to 256 colours with ordered [pass 1] and Floyd-Steinberg [pass 2] dithering to enhance the
display of true colour and high colour previews and thumbnails on a 256 colour display 



Do not use ordered dithering to enhance the display of true colour previews and thumbnails on a high colour display.



Use ordered dithering to enhance the display of true colour previews and thumbnails on a high colour display



Place the viewer window on top of all other windows, even when it is not the active window



Use the entire display to view images



Show the tool bar



Show the status bar



Show the menu bar



Show the box containing the path of the current folder



Show the folder tree



Show the shortcuts panel



Show the preview area



Shrink large images to fit the size of the viewing window



Zoom small images to fit the size of the viewing window



Return the zoom level to 100% whenever a different image is viewed



Automatically change the size of the viewing window to match the size of the image



View externally opened images with a new instance of ACDSee.



View externally opened images with the current instance of ACDSee, if one is available.
The images are added to the current image list.



View externally opened images with the current instance of ACDSee, if one is available.
The current image list is emptied before new images are received.



Remove all images in the image list before adding dropped files. 



Append dropped files to the current image list.



This is the path containing the files which will be moved or copied



This is the path to which the files will be moved or copied.
Type in a path, select one from the most recently used list below, or click on Browse…
If you enter a path that does not exist, it will be created for you.



Click this to choose another path.    You’ll be able to browse through the folders on your computer. 



Removes the selected path from the history list.



Removes all paths from the history list.



Specifies the action to be taken when a file that is being moved or copying already exists in the destination folder.

Replace Overwrite the destination file with the source file.
Skip Skip the operation.
Rename Move or copy the source file, giving it a new name that is unique in the destination folder.
Ask Prompt for a course of action.



Perform a byte by byte comparison before overwriting files in the destination folder.    If the files are identical, the file is
automatically skipped (the source file is removed if performing a move operation).



Goes ahead and moves or copies the files.



Cancels the move or copy operation.



Select the program you want to use from the list.    If the program you want to use is not in the list, click Other…



Enter any command-line parameters that you want passed on the command-line to the program.
(For example, Media Player accepts the /play option, which causes it to automatically play the media file and exit 
media player when done.)



Specifies that whenever you open this file, or any other file with the same filename extension, Windows will use the 
program specified.



Click this to choose another program.    You’ll be able to browse through the folders on your computer.



Attributes of the file that will be overwritten



Attributes of the file that is being copied or moved



Specifies the new name for the source file



Copies or moves the file source file, replacing the destination file.



Skips this file so that it is not copied or moved



Move or copy the file, giving it the name specified.



Replaces this and all subsequent files without asking for confirmation



Cancels the entire move or copy operation.



View of the image that will be copied or moved.



View of the image that will be overwritten.



Do not show source or destination images.



Show thumbnails of the source and destination images.



Show the source and destination images at their actual size.



Specify that when you scroll one of the images, the other should follow in sync.



Sets the width of the thumbnail images



Sets the height of the thumbnail images



Sets the border thickness of the thumbnail images



Displays how the thumbnails will appear in the file list



Keep the mouse cursor over the clicked button (Prev. Image, Next Image, Zoom In, Zoom Out) when the action of the
button causes the window position to change.    This option is only relevant when Change window size to fit image 
option is on.



Hide the mouse cursor when viewing in full-screen mode.    The mouse cursor will only be shown when one of the 
mouse buttons is pressed.



Cause the auto window resize mechanism to center the new window position over the preferred window position.    
(The preferred window position is the last position to which the window was moved manually)    Otherwise, the new 
window position is chosen such that the position of the upper-left hand corner of the window is unchanged, if 
possible.    This option is only relevant when Change window size to fit image option is on.



Use device-dependent bitmaps for displaying images, previews and thumbnails, rather than device-independent 
bitmaps.    The following table describes the difference between the two bitmap types.

Device-dependent bitmaps (DDBs) Device-independent bitmaps (DIBs)
Slower decoding of images Faster decoding of images
Faster display, zooming and panning Slower display, zooming and panning
More memory required for some images. Less memory required for some images.
Very large images cannot be displayed. Images of virtually unlimited size can be displayed 

The magnitude of quantitative differences between DDBs and DIBs varies from system to system.    Some systems 
do not correctly support DIBs due to video driver bugs.



Modify the list of which file types are opened with ACDSee when double-clicked in Explorer.



In report view, allow items to be selected by clicking anywhere in the row, rather than only on the icon or label.    

This option is only available on systems with an updated version of comctl32.dll (v4.70 or later).



In report view, draw gridlines between rows and columns.    

This option is only available on systems with an updated version of comctl32.dll (v4.70 or later).



Highlights image files.    (This option has no effect when the “Show images only” option is in effect.)    

This option is only available on systems with an updated version of comctl32.dll (v4.70 or later).



Do not save or restore the position or dimensions of the window.



Save and restores the size but not the position of the window.



Save and restores the size and position of the window.



Hide the preview area and do not show previews when in thumbnail view mode.



Automatically update the file list as the contents of the current folder change.



Select new files that have been added to the file list due to the auto-refresh feature



Set placement of new files that have been added to the file list due to the auto-refresh feature



Show folders when in thumbnail mode.



Show non-image files when in thumbnail mode.



Disables the animation of animated GIF images.



Displays the Print Setup dialog before printing.



Prints the visible contents of the window only.



Prints the entire image.



Centers the image in the page.



Prints the image at the top of the page.



Prints the image’s file name.



Prints the image’s file description.



Prints the image’s resolution and format.



Prints one image per page.



Automatically sizes the image to fit the page.






